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PENGEMBANGAN MEDIA PEMBELAJARAN

1 MEMBUAT EVALUASI
Evaluasi merupakan hal sangat penting untuk menguji seberapa dalam 

materi  yang  yang  sudah  dikuasi  oleh  siswa.  Untuk  membuat  evaluasi 
sederhana dengan flash, maka dapat dilakukan dengan cara sebagai berikut.

1 STEP 1
1. Atur ukuran layar yang akan digunakan untuk menampilkan media ini. Biasanya 

ukurannya adalah 800 pixel x 600 pixel. Lihat bagian properties.

2. Buat layer dengan nama bacground untuk menempatkan warna latar yang kita 
inginkan. Pada frame 10, klik kanan kemudian pilih Insert frame. Pada layer ini 
pilihlah warna latar yang diinginkan.

3. Buat layer dua bernama kotak. Secara otomatis panjang frame pada layer kotak 
mengikuti panjang frame layer sebelumnya. Pada frame 2, klik kanan dan insert 
keyframe. Sekarang buatlah kotak untuk menempatkan soal yang akan diujikan.

4. Buat layer soal. Pada frame 1, buatlah tulisan “INI ADALAH PETUNJUK 
MENGERJAKAN SOAL”. Pada frame 2 insert keyframe dan hapus tulisan “INI 
ADALAH PETUNJUK MENGERJAKAN SOAL”. Sekarang dapat mulai membuat 
soal.
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5. Pada  frame  2  layer  soal  tuliskan  'INI  SOAL  NOMOR  1'  yang 
ditempatkan  di  atas  kotak  membuat  soal.  Kemudian  dibawah  kotak 
tempatkan tombol-tombol pilihan A, B dan C. Dimisalkan jawaban yang 
benar adalah A. Lihat gambar dibawah. 

6. Pada  frame  3  layer  soal tuliskan  'INI  SOAL  NOMOR  2'  yang 
ditempatkan  di  atas  kotak  membuat  soal.  Kemudian  dibawah  kotak 
tempatkan tombol-tombol pilihan A, B dan C. Dimisalkan jawaban yang 
benar  adalah  B.  Demikian  seterusnya  sampai  berapa  soal  yang 
diinginkan.
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7. Pada  frame  5  layer  soal  tuliskan  Hasil  Evaluasi.  Dibawah  tulisan 
tersebut  tuliskan  Benar,  Salah  dan  Prosentase.  Disamping  tulisan 
tersebut masukkan dynamic text dan variabel masing-masing dynamic 
text berilah nama benar, salah dan prosentase.

8. Buat layer Tombol. Pada frame 1 masukkan tombol Next dan Back (untuk lebih 
mudahnya, ambil saja dari Library. Kalau button library belum ada, maka dapat kita 
tampilkan dengn cara pilih Window > Common Libraries > Buttons. Selanjutnya 
akan tertampil pilihan-pilihan tombol yang dapat kita ambil. Tempatka tombol 
tersebut di kanan bawah. Berilah nama tombol tersebut dengan 'next_btn' yang 
disikan pada bagian instant name.
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9. Buatlah satu layer lagi bernama Script. Di dalam layer Script ini nanti 
kita akan tempatkan action script untuk media ini.

2 STEP 2
1. Pada frame 1 layer Script, tuliaskan script seperti dibawah ini.

stop();

benar=0;

salah=0;

next_btn._visible=true;

back_btn._visible=false;

2. Pada frame 2 insert keyframe dan berikan script 

next_btn._visible=false;

3. Pada frame 5 layer script insert keyframe dan tuliskan script seperti di 
bawah ini.

back_btn._visible=true;

prosentase=benar/(benar+salah)*100;

3. Arahkan  pointer  pada  layer  soal.  Pada  frame  2,  yaitu  tempat  soal 
nomor 1, berikan action script pada tombol A_btn dengan

on(release){
benar=benar+1;
nextFrame();

}
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Berikan action script pada tombol B_btn dengan
on(release){
salah=salah+1;
nextFrame();

}
Berikan action script pada tombol C_btn dengan

on(release){
salah=salah+1;
nextFrame();

4. Masih di layer soal, sekarang berikan action script seperti dibawah ini

 Berikan action script pada tombol A_btn dengan

on(release){
salah=salah+1;
nextFrame();

}
Berikan action script pada tombol B_btn dengan

on(release){
benar=benar+1;
nextFrame();

}
Berikan action script pada tombol C_btn dengan

on(release){
salah=salah+1;
nextFrame();

5. Arahkan pointer  pada layer  Tombol.  Klik  pada tombol  next_btn dan 
berikan action script seperti di bawah ini

on(release){

nextFrame();
}

6. Masih di layer Tombol dan select tombol back_btn, kemudian berikan 
action berikut

on(release){
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gotoAndPlay(1);
}

2 MEMBUAT MEDIA PEMBELAJARAN SEDERHANA
Pada pasal ini kita akan membuat media pembelajaran sederhana yang 

terdiri atas ruang untuk menampilkan deskripsi konten dan tombol navigasi 
untuk menuju ke konten. Untuk lebih jelasnya ikuti langkah-langkah berikut 
ini

1. Buatlah layer background, kemudian pilihlah bacground sesuai dengan keinginan 
anda. Kemudian pada frame 6 insert frame.

2. Buatlah layer kotak untuk menempatkan tombol navigasi dan deskripsi konten.

3. Buatlah  layer  tombol.  Pada  layer  tombol  ini  buatlah  tombol  dan 
tempatkan di atas kotak tombol dibawah menu yang sudah disediakan.
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4. Buatlah  layer  deskripsi.  Pada  frame  1  tuliskan  'INI  ADALAH 
HALAMAN INTRO'.  Insert  keyframe pada  frame  2  dan  tuliskan  'INI 
ADALAH  HALAMAN  MATERI'.  Insert  keyframe  pada  frame  3  dan 
tuliskan  'INI  ADALAH  HALAMAN  LATIHAN'.  Insert  keyframe  pada 
frame  4  dan  tuliskan  'INI  ADALAH  HALAMAN  EVALUASI'.  Insert 
keyframe  pada  frame  5  dan  tuliskan  'INI  ADALAH  HALAMAN 
GLOSARY'.  Insert keyframe pada frame 6 dan tuliskan 'INI ADALAH 
HALAMAN PROFIL'.

5. Buatlah layer Script. Pada frame 1 tuliskan script

stop();

6. Kembali ke layer tombol dan berikan action script pada tombol-tombol 
yang sudah kita buat. 

a) Untuk tombol Intro berikan action script

on(release){

gotoAndStop(1);

}

b) Untuk tombol Materi berikan action script

on(release){

gotoAndStop(2);
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}

c) Untuk tombol Latihan berikan action script

on(release){

gotoAndStop(3);

}

d) Untuk tombol Evaluasi berikan action script

on(release){

gotoAndStop(4);

}

e) Untuk tombol Glosary berikan action script

on(release){

gotoAndStop(4);

}

f) Untuk tombol Profil berikan action script

on(release){

gotoAndStop(6);

3 ACTION SCRIPTS
Dalam  membuat  media  pembelajaran,  kita  tidak  lepas  dengan 

penggunaan action script. Penggunaan action script akan membuat file media 
kita lebih kecil, sehingga loading filenya akan lebih cepat. Pada pasal ini kita 
akan mempelajari bagaimana mengenakan action script pada objek yang telah 
kita buat.

1 Membuat Objek Bergerak ke kanan dan ke kiri
Untuk membuat gerakan ke kanan dan ke kiri pada objek, maka ikuti 

langkah-langkah berikut ini:

1. Buat objek, misalnya kotak dan ubah menjadi bentuk movieclip, caranya 

Modul Workshop Pengembangan Media Pembelajaran,, 21 Nopember 2008 8



Supardi, M.Si

select all pada objek, kemudian pilih menu Modify > Convert to 
Symbol > movieclip.

2. Setelah objek menjadi simbol movieclip, kemudian berilah nama objek tersebut dengan 
kotak_mc. Select objek dan berilah script berikut

onClipEvent(load){
this._x=0;
}
onClipEvent(enterFrame){
this._x=this._x+10;
}

3. Perhatikan gerakan objek. Ternyata objek bergerak terus ke kanan dan tidak pernah 
kembali. Agar objek bergerak ke kanan dan ke kiri, maka kita perlu menambahkan 
script lagi seperti di bawah ini.

onClipEvent(load){
gerak="kanan";
}
onClipEvent(enterFrame){
if (gerak=="kanan"){
this._x+=10;
if (_x>700){

gerak="kiri";
}

}else {this._x-=10;
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if (_x<-200){
gerak="kanan"}

}
}

atau dengan cara yang lebih mudah buatlah script seperti di bawah ini

onClipEvent(load){
n=10;

}
onClipEvent(enterFrame){

this._x+=n
if (this._x>550 or this._x<0){

n=-n;
}

}

4. Untuk dapat melihat pada posisi berapa objek berada pada saat itu, maka kita perlu 
menambahkan dynamic text di stage. Berilah nama dynamic text tersebut dengan 
posisi_x. Setelah itu tambahkan script seperti di bawah ini.

onClipEvent(load){
gerak="kanan";
_parent.posisi_x=this._x;
}
onClipEvent(enterFrame){
_parent.posisi_x=this._x;
if (gerak=="kanan"){
this._x+=10;
if (_x>700){

gerak="kiri";
}
}else {this._x-=10;
if (_x<-200){
gerak="kanan"}
}
}
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2 Membuat Objek Terjebak dalam Kotak
Pada bagian ini kita akan membuat sebuah objek yang terjebak di dalam 

sebuah  kotak,  hingga  tidak  dapat  keluar  lagi.  Untuk  membuatnya  ikuti 
langkah-langkah berikut ini.

1. Buat layer 1 dan berinama kotak. Dalam layer ini buatlah sebuah kotak 
yang akan kita gunakan untuk menjebak objek.

2. Insert  layer  2  dan  berinama partikel.  Pada  frame  1  buatlah  sebuah 
objek  berbentuk  lingkaran.  Setelah  selesai  ubahlah  objek  tersebut 
menjadi tipe movieclip dan berilah nama dengan partikel_mc
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3. Insert layer Script dan tuliskan actionScript seperti di bawah ini

var laju_x:Number=-50;
var laju_y:Number=-50;
partikel_mc.onEnterFrame=function(){
this._x+=laju_x;
if(this._x>400 or this._x<120){

laju_x=-laju_x;
}
this._y+=laju_y;
if(this._y>270.8 or this._y<60.8){

laju_y=-laju_y;
}
}

3 Menggerakkan objek dengan tombol
Pada  bagian  ini  kita  akan  belajar  tentang  bagaimana  untuk 

memindahkan suatu objek dengan menggunakan tombol panah kiri,  kanan, 
atas dan bawah. Untuk lebih jelasnya ikutilah langkah-langkah beikut ini.
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1. Buat satu layer bernama gambar. Import gambar ke stage dengan cara 
pilih File > Import > Import to Stage.

2. Insert layer dan beri nama objek. Dari layer ini buatlah seuah objek, 
misalnya  balon  dan jadikan menjadi  bentuk  movieclip.  Berilah  nama 
objek tersebut dengan balon_mc.
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3. Buat layer teks. Tempatkan dynamic teks di tempat tertentu dan berilah 
nama dengan informasi_text.

4. Insert  layer  satu  lagi  bernama  Script.  Pada  frame  1  tuliskan  script 
seperti di bawah ini.

informasi_text.text="Gunakan tombol anak panah untuk menggerakkan 
balon";

var laju:Number=10;
balon_mc.onEnterFrame=function(){
if (Key.isDown(Key.RIGHT)){

this._x+=laju;
}
if (Key.isDown(Key.LEFT)){

this._x-=laju;
}
if (Key.isDown(Key.UP)){

this._y-=laju;
}
if (Key.isDown(Key.DOWN)){

this._y+=laju;
}
}

4 Membuat Efek 3 dimensi.
Dengan mengatur pada bagian properties objek dengan action script 

maka  kita  dapat  membuat  kesan  bahwa  sebuah  objek  adalah  3  dimensi. 
Caranya adalah

1. Masukkan gambar logo UNY.
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2. Jadikan objek tersebut menjadi movieclip. Kemudian dengan select pada 
objek, tuliskan perintah sebagai berikut

onClipEvent(load){
n=5;

}
onClipEvent(enterFrame){

this._xscale+=n
if (this._xscale>100 or this._xscale<-100){

n=-n;
}

}
Kita dapat pula memberikan action pada frame. Caranya klik frame 1 

layer Script dan berikan script seperti di bawah ini

var laju:Number=5;
uny_mc.onEnterFrame=function(){
this._xscale+=laju;
if (this._xscale>100 or this._xscale<-100){

laju=-laju;
}

}

5 Membuat animasi putar
Animasi  putar  sangat  mudah  dibuat  dengan  actionScript.  Inilah 

langkah-langkahnya.

1. Buatlah layer objek. Buatlah sebuah lingkaran seperti terlihat dibawah 
ini. Jangan lupa jadikan menjadi bentuk movieclip. Berilah nama objek 
tersebut  dengan  lingkaran_mc.  Untuk  memperoleh  lingkaran  yang 
benar-benar  bulat,  caranya  sambil  membuat  lingkaran  tekan  tombol 
Shift. Tambahan lagi, agar objek kelihatan perputarannya maka hapus 
sedikit bagian samping lingkaran. Lihat ganbar di bawah ini.
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2. Insert layer Script. Berikan script pada frame 1 layer script.

var laju:Number=5;
lingkaran_mc.onEnterFrame=function(){
this._rotation+=laju;
}

6 Fungsi startDrag dan stopDrag
Fungsi  startDrag  sangat  penting  manakala  kita  menginginkan  objek 

dapat  diseret  ke  manapun  kita  suka.  Untuk  menggambarkan  penggunaan 
fungsi tersebut, marilah kita ikuti langkah-langkah berikut ini

1. Buat  layer  1  bernama  objek.  Di  layer  ini  buatlah  objek  sembarang 
berbentuk movieclip dan berilah nama objek_mc.
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2. Insert layer dan berinama Script.  Sekarang tuliskan script seperti  di 
bawah ini

objek_mc.onPress=function(){
startDrag("objek_mc",true);

}
objek_mc.onRelease=function(){

objek_mc.stopDrag();
}

7 Membuat Animasi Sinusoidal
Untuk membuat animasi berupa grafik sinus dapat kita lakukan dengan 

cara sebagai berikut:

1. Buat layer Scrip dan buatlah seperti di bawah ini

lineStyle(1,0x000000, 100);
moveTo(0,100);
a=50; //amplitudo
b=50; //frekuensi
for(x=1;x<500;x++){

y=a*Math.sin(b*x);
lineTo(x,y+200)
trace("x="+x+";y="+y);

}
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8 Mempublish file Flash
Setelah kita selesai membuat semua hal mengenai media pembelajaran 

dengan flash, maka seterusnya adalah mempublish file flash yang kita miliki. 
Untuk mempublish file flash dapat dilakukan dengan cara pilih menu File > 
Publish Settings. Kemudian akan muncul jendela Publish Settings seperti di 
bawah ini. Kita pilih menjadi file apa media yang ingin kita peroleh, apakan 
dalam format .swf, .html, .exe atau yang lainnya. Akan tetapi, biasanya kita 
memilih format .exe agar dapat dijalankan secara mandiri.

Setelah  dipilih  format  seperti  yang  kita  inginkan,  selanjutnya  pilih 
Publish dan OK.

9 Membuat AutoRun
Apabila media pembelajaran sudah dikemas dalam sebuah cd, ketika cd 

kita  masukkan  dalam  komputer,  maka  secara  otomatis  komputer  akan 
langsung  memainkan  media  pembelajaran  yang  ada  di  dalam cd  tersebut. 
Untuk itu diperlukan penyertaan file bernama AutoRun yang disimpan dalam 
satu tempat dengan media yang kita miliki. Secript untuk Auto Run adalah 
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sebagai berikut

[AutoRun]
open=aplikasi.exe
icon=aplikasi.ico

Setelah dibuat file itu dalam notepad, kemudian simpan file autoRun 
tersebut dengan ekstensi .inf
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